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1. Master File:  

a. Unit: In this menu, there is unit list of different items that we can create for different 

items, like as for chemicals there is unit ML (milliliter), Grams(gm) etc. 

 

b. Item Category: In this, we can add item category under consumable and non-

consumable item type by selection or clicking on given button Add New Category 

 

By clicking on Add New Category button, we can add new item categories as shown below. 

 

 

Add New Category 



c. Item Sub-category: Under this We can add item sub-categories for created item 

categories.  

Select Category→ Add New Sub category→ Write Sub category name and code  

Sub category will created under for that particular item category. 

 

 

d. Item: Like as there is a list of items, to add new items under any category and 

subcategory, we can add item by clicking ADD New Item button. 

 

 

 

 



e. Vendor: There is a list of vendors that we can add from given button ADD NEW as 

below. 

 

f. PO letter Master: There we can add PO (Purchase Order) Terms and condition file for 

different item’s purchasing (like as for chemicals, furniture, stationary etc.) by clicking on 

ADD New Button. 

Then during Generate Purchase Order, we can directly upload this Terms and Condition file for that 

particular item purchasing. 

 

 

 

 

 

 

 

 



g. Source of Fund: There we can add new source of Funds through which items are 

purchasing under Store and Purchase Section. 

Like as there is created list of Source of Fund. 
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In Academics Login  

Select any Role & Academic Session 

 

 

 

Figure 1 Login Panel for different Session 

 



MAIN DASHBOARD: 

After Login There are many links to check some particulars: 

❖ Message 

❖ Student MIS 

❖ Fee 

❖ Attendance 

❖ Exam 

❖ COS 

❖ Security 

❖ Settings 

 

1.  Student MIS: There are below mentioned facilities 

 

 
 

1. Student Update, you can add new student and you can view student list by clicking on given 

tabs in that particular related Programme. In the main screen, it shows all registered students 

list under different programmes semester wise. 



 

Figure 2 To check registered Students under each Programme 

By Clicking on View Student Tab, we can check registered student list under various Programmes and by 

clicking on ADD Tab we can add new students to already created list. 

Like as by clicking on VIEW ATUDENT TAB, under this we can change student detail or basic information 

also as in below screen. 

 

           Figure 3 To change or update student information 

 



By clicking on Update profile, can update information about student. Like as in below screen, after changing 

any information, then save that by clicking on SAVE button. 

 

We can remove registration of student by clicking on REMOVE tab. To show student stuff of, if student has 

cancelled own registration, then we stuck off that student by clicking on STUCKOFF tab. 

If we want to update about year back status of any student, then we can update from this tab. 

2. Student List Verification 

Under this, we can verify the list of students list under different Programmes. 



 

Figure 4 To verify the Registered Students in each Programme 

 There is an approved list to check or view the students (in View Student tab) in any particular 

given Programme. 

 

3. Set Student Category: We can edit the Fee category of student accordingly. 

 

 

Figure 5 To set Category of students 



4. Student Email/Mobile: we can edit Email and mobile no. of any student by selecting 

Programme and semester of that particular. 

 
 

5.  View All Academic Details: There is a list of students, in which you can view Active 

Students details under particular Programme with section wise of any Department by clicking 

on SELECT Tab. 

SELECT  VIEW SUBJECT        VIEW EXAM  ATTENDANCE SHEET 

   

                         STUDENT REGISTRATION 

 



 

Figure 6 Department wise List under each Programme 

   

5.1   It shows Present no of registered students under any particular Programme with section wise in 

all semester. It gives detail of class counselor, time table incharge. So, that student can concern 

to that related teacher if there is any issue in time table or any related to class. 

 

 

          Figure 7 Section Wise No of Registered Students 

5.2  you can view all subjects of that Programme by clicking on VIEW Subject Tab. 

 



 

Figure 8 Subject Wise list in each Programme 

In View Exam Tab , it shows the detail of subject with exam marks  detail and related to concern course and 

semester. From which we can generate Attendance sheet according to concern exam. 

 

Figure 9 To generate Attendance Sheet 

5.3  By clicking on Student Registration Tab we can check list of registered students under that 

particular Programme section wise. 



 

Figure 10 No of Registered students in each subject 

6. Student MIS 

This is for Student Management Information System. In which we can generate 

list of students as per our need. 

SELECT PROGRAMME TYPE  →     SELECT BATCH/CATEGORY →    SELECT FIELD NAME   →             

PRINT PREVIEW            

 

Figure 11 Check list of students with different categories and different fields 



In this Menu we can take the list of different batches and different courses student. 

  
Here we can select program type and can select any batch and any category of which type column 

you want in your student list. 

  From there we can select that fields, which you want 

in your list. That column name will also shown in right side box. You can download your excel 

sheet from upper right side part after clicking on Print Preview  then there will appear excel 

shortcut. 



 

Figure 12 Final Excel List with different fields 

 

7.  Student All Details: 

 

 

Figure 13 check detail of student  fee in different Programme 



 

Figure 14 Search Student by Admission No or Name 

We can check the detail of student regarding their semester fee or by exam fee registration by writing their 

admission no. or name. We can check it as mentioned in above picture. 

We can view the DMC of related to that student by clicking on VIEW DMC Tab. 

 

Figure 15 DMC sample 

From View Profile Tab, we can check student information or detail. 



 

   Figure 16 Student Information 

8. Student Batch Wise List (R): In this type of report there is batch wise student list can be 

generated with full description like as student information with mobile no. , father name, 

semester, batch, year back report etc. 

 

Figure 17 Batch wise Student report 



9. Student List (Rpt) 

  In this link you can view List of Students Section Wise, Batch Wise, Trade Wise, Drop 

out List, Minority Wise List also. 

 

Figure 18 Session Wise Student List 

We can check or download different types of lists by clicking on given different tabs as mentioned in 

above screen. 

In this Batch wise report is generated as to check only batch wise total no of students under any 

course. 

 

9. Student Certificate:  

 You can view the stuck off students list and can view their certificate by clicking on View Tab. 



 

Figure 19 To view stuck off student certificate 

 

9.1   After filling all the detail of particular student of which you want to create and print his/her DMC 

& certificate.

 



10. Student Certificate New: You can view the students list after filling all required fields, after that 

you can view their related certificates after clicking on VIEW tab. 

 
 

Fees Dashboard 

1. Department Fee: We can check the Department wise fee of students and we can issue 

certificate regarding that. 



 

Figure 20 To check department Fee 

2. Certificate Issue: 

  In this link we can issue certificate regarding any pendency. There are three different 

links for issuing the certificate  . New Inquiry . Issued Inquiry . Rejected List 

 

 
 

Attendance Dashboard: 



 

1. Subject Wise Student: In this link we can check semester wise, session wise list of students 

according to their subjects. 

Same Trade /Sem—All Department  

There are two options like this in which we can generate list of students accordingly. 

Same Trade/ Sem means that which trade and semester have fill in upper fields and  

All department means that it will generate list of all department students list for that particular 

selected subject accordingly. 

 



 
Like as in Open elective subject, there are students in all department that we can check directly to 

all them by selection All Department option. 

 

2. Mapping of Subject To Semester: In this we can generate or assign subjects according to their 

session and semester. 

 

Figure 21 Subject Scheme in Semester 

3. Mapping of subject to section 



 
In above, subjects are assigned section wise which were added previously to which semester. 

 

4. Mapping of Subject to Sem Verification 

           In this all subject list will open of verified semesters. We can view the subjects list by clicking 

on VIEW tab. 



 
 

5. Regular Subjects Registration 

 

5.1 In this there is View student Tab in which we can check the students list under that particular 

Programme. 



 

Figure 22 List of Students in each Programme 

After that there are two tabs VIEW SUBJECTS and REMOVE REGISTRATION 

From View Subject Tab we can check the subjects list of that particular student, if subjects are not 

assigned to that student then teacher can assign subjects or can register the student for that 

particular regular subjects. 

Like as in below screen , on left side there are regular subject according to the session and trade, 

by selecting that subjects and after that click on Insert button , all subjects will insert in student 

account and  from Remove Registration Tab we can delete or cancel the registration of that 

student in case of any issue. 



 

Figure 23 Regular Subject Registration 

10. Regular Subject Registration Verification:  In this there is approved list, in which there are 4 

parts  

a. View Student 

b. Print Registered 

c. Print Not Registered 

d. Activity List 

These above links are used for different purposes, like as in View Student we can check the list under 

that particular Programme. 

In Print registered we can take print of that registered students list. 

In Print Not Registered we can check and can take print of that students list who have not registered 

till.  



 

         Figure 24 Regular Subject Registration verification 

11. Re-Exam Subject 

 

Figure 25 Re-exam  subject Registration 

In this student registration for Re-exam has to do, after verification it has locked by HEAD.  

 

 

 



12. Repeat /Retest Registration Verification 

 

There is Approved , Pending And Rejected List. From where you want to update any record that you 

can, to verify the registration regarding repeat or re-test subject registration. To update the record of 

any student regarding re-exam, click on Update tab. 



 

Here we can check approval for test of that particular student. 

13. Repeat/Retest Registration List: 

After verification of the Retest List we can download or take print of that from this link after 

selecting particular Programme and Exam Name. 

 



 
 

14. Assign Subject:  

Through this link we can check the assigned subject of any particular semester and Programme 

type with the credits of that subjects accordance Lecture, theory, Practical scheme. 

 

Figure 26 To check Semester and course wise Subjects 

 



15. Subject Activity: 

 

Exam Dashboard 

 



 1. Mapping of subject to Faculty Retest

 

 In this firstly we have to click on SELECT EXAM Tab to change any subject wise faculty. 

1.1 In Faculty Retest there three types in each we can edit subject wise faculty by clicking on view 

Subject. 

 

1.2  After clicking View Subject :we can change faculty name under that particular subject by 

selecting Department name and after that select faculty name. 



 

2. Generate Exam Paper 

 

3. Generate Exam Back Paper : 



 

There  are 3 tabs View Student, Exam Create, View Max Marks 

In View Student we can check student under each Programme. 

 



4. Generate Exam Retest 

4.1  Here is department wise list, select any department to generate exam for that

 

There is Select Exam Tab to related to each department, of which department and of which subject 

have to generate for retest.  

 

 

 

 

 

 

 

 

 

 



4.2 View Subject Tab 

 

After click on Select Exam Tab, there are three options from which have to fill retest exam, select that 

option. 

Like there is Retest_May-2022, Select it. 

4.3 There are some tabs from which we can check about student, their exam and their result 

a. View Student   

b. View xxx exam 

c. View result 

 



5. Exam Max Marks Verification 

 

There is an approved list in which there is view tab, from which we can check max marks of subjects 

related to that particular Programme. 



 

  Figure 27 Subject Max. marks List under different  Programmes 

6. Marks Enter Retest Verification  

 



There are three types of exams –session wise, from which we have to click on  select Exam Type Tab. 

There is a list of exams which were given in Retest_May-2022. From where we can check award sheet 

of that particular student and can view Exam 

 

Through Award Sheet Tab We can see award sheet like as follow 



 

 Figure 28 Preview of Award Sheet 

7. CGPA Report 

 



After filling all required fields, CGPA report will generate accordingly. 

8. Repeat Grade Update 

9. Award List Verification 

  There is two types list one is to List for Verify and Approved List. Under this we can verify the 

award list that has generated according to their exam’s and test’s marks. 

 

Figure 29 Department wise Approved List 

Through the View Subject Tab, we can check subject wise detail of different Programmes of different 

sections. 



 

Here is list of subjects with two different Tab facilities: 

a. View subject Marks 



 

Figure 30  Show marks fill status (that has filled or not) 

b. Award Sheet 

 
 



10. Final Subject Approved 

 In this registered subjects for Retest, Re-exam, Summer Exam has verified and if find all are 

correct then has to approved by academics. 

 

➔ From View Subject Tab: Firstly here it shows department wise list , from which we can check 

exam list under that particular department by clicking on SELECT EXAM Tab, as in below 

screen. 



 

Figure 31 Department List 

After Click on Select Exam Tab 

 

Figure 32 Semester Wise Course 

Here we can select according to semester 



 

After that we can Check or view grade accordingly. 

 

In this we can check result of each and every student according to trade and session wise. 

16. Student Checking:   

           In student checking we can check student year details and exam details related to that. 

As per below screen, here are two options related to that Student Year Details, Exam Detail in 

which we can check students accordingly. 

 



 

     Figure 33 Student Year Details 

If we click on Exam Details Tab, it will show as below screen. 

 

By clicking on UPDATE  Tab, it will show list of Exam wise detail & that list we can export into 

excel as well by clicking on excel link or can take print of that list through Print button. 



 

Figure 34 Exam Detail list of Students 

17. Student Thesis 

 
 Here we can check thesis of students whether they have submitted or not accordingly. 

 

 

 



COS Dashboard: 

1. Create Course Outcomes 

 

By clicking on View Subject Tab we can check: Course Outcomes, Target Marks, COs POs mapping. 

 

Setting Dashboard: 

1. Admission Seat: In this we can add or delete no of seats under any course like as in below 

screen. 



 

Figure 35 To add no of seats under any course 
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DashBoard: There is following menu for Accounts 

 

 

 

 

 

 

 

 

 

 

• Under Account_Master 

There are some sub-menu under Account_Master like as following:- 

a. Account Group: 

 



 

 

 

 

 

 



b. Account Group Map register: 

 

c. General Ledger 

 



 

d. Sub Ledger 

 



 

e. General Ledger (Op Balance) 

 

 



f. Sub Ledger (Op balance) 

 

g. Add/Create Party 

 



h. Add Employee for Account 

 

i. Cheque Master 

 



j. FD Fund Master 

 

k. Works Master 

 



l. Account Auth Signatory 

 

• Account_Transaction 

In Account_Transaction → Direct Cheque Transaction→ Cheque Cleaning Date 

a. Direct Cheque Transaction: 

 



b. Cheque Clearing date: 

 

• Account_Register 

Party Payment Entry→Advance Register Entry→Imprest Bill→ TA Register Entry→Children 

Education Allowance→ FD Register Entry→Grant Regsiter Entry→Medical 

Reimbursment→Employee Payment Regiter→LTC Advance Register→ PDA Register Entry→OTA 

Register Entry 

 

1.On which date 

cheque has cleared 

2. Save data after fill 

date 



a. Party Payment Entry: There is New Entry List and Lock List 

We can make New Entry also. 

In below there is new entry list under party payment entry. 

 

Figure 1 New Entry List 

 

Figure 2 Lock List 

b. Advance Register Entry: There is also New Entry, Lock List, Payment List 



 In New Entry List:  We can make payment under this by selecting that particular file no and then click on 

PAYMENT Tab. 

 

Figure 3 New Entry List to Make  Payment 

 

Under this payment list , we can take print of application and cheque. 

 

 

 



c. Imprest Bill: 

 

d. TA Register Entry 

 

e. Children Education Allowance 

f. FD Register Entry: Here is a list of  different FDs and we can make new entry under this and after 

maturity of that FD we can Re-New it. 



 

Figure 4 FD Entry 

g. Grant Register Entry 

 

We can check registered entries under this and can make new entries also. 

h. Medical Reimbursment 

 

 

 

 



i. Employee payment Register: We can make new entries also, 

 

j. LTC Advance Register 

 

We can add new in this list. 

k. PDA Register Entry 

l. OTA Register Entry: in this we can make entries of overtime allowance. 

 

 

 

 

 



• Account_Voucher: 

 

a. Journal_Voucher: 

 

b. Bank Receipt Voucher 



 

c. Bank Payment Voucher 

 

d. Cash receipt Voucher 



 

e. Cash Payment Voucher 

 

 

 

 

 

 

 

 

 



• Account_ Register Reports 

 

 

 

 

 

 

 

 

a. Party Payment Register(Rpt) 

 

b. Work Register Repport 



 

c. TA Register Report 

 

d. Medical Reimbursment Report 

e. Imprest Bill Register Report 

 

 

 



• Account_Reports 

 

a. Print Voucher: We can take print of report by voucher no and cheque no. 

 

b. Current Vouchers: Here is list of current vouchers . 



 

c. Print payment Letter 

 

d. Day Book Report: We can take print of journal Voucher, cash book and Bank Book according 

to date. And can down;oad soft copy of it. 

 

 

 

  



 

e.  Statement 

 

f. Bank Day Book 



 

g. Trail Balance: 

h. Trail Balance Group Wise: 

 

 

Figure 5 Print Preview for Balance 

i. Ledger List Report 

 



j. FD  Register Report 

 

We can take print of that report  and Can export into excel. 

k. Grant Register Report 

 

l. TDS Deduction Report: Which type of tax deduction of that type report we can take print or can export 

into excel. 



 

m. Cheque Register Details 
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LOGIN PROCESS: 

Select Role for Login: 

 

Student MIS: 

1. Student Course update 

In this menu, we can make changes regarding any course updation of student. Like as in below screen, 

there is a list of different courses, we can select accordingly. 
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Figure 1 Student Course Updation 

As there are some more options to make changes under course updation like as in batch, seat to select 

fee_category, academic year etc. 

After make changes save it. 

2. Attendance: 

a. Re-Exam Marks Roll Back 

 

If marks of students in any type of Re-exam, retest or summer type has filled wrong or any other mistake then 

Assistant Registrar can roll back all that data, so that correction can be done in that data. 

 



3. Exam:   

a. Exam Name create: In this Assistant Registrar can create exam or can schedule exam, which type 

of exam has to schedule. ( like as Summer exam. Repeat, retest exam). 

 

    Figure 2 Create Exam Session Wise 

b. Change exam Grade: Under this we can change grade of any student under any type of exam . if 

there is any change required. 

 

Figure 3 To change Exam grade 

Before registration date has to locked, it can be change manually. After the Registration date has locked , we 

can’t change any grade under any student subject. 



c. Award List Verification:  

Under this, there are two types of list. One is of list for verify and Approved list 

In the list for verify here is pending list for approval and one is there that has approved. 

 

Figure 4 Award List Verification 

Under View Subject Marks Tab, there is to check marks fill status under that particular branch and 

Programme. From here there is Award sheet Tab , from where we can check award sheet of that branch for 

any particular subject. 

 

Like as below there is Award sheet view,. 



 

Figure 5 Award List 

4. Settings: 

a. Academic Year Registration Date: 

From here Registrar can set registration date, exam date, session date etc. 

 

Figure 6 To set Academic Registration Date 



 

Figure 7 set registration date semester wise 
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Select role Class Counselor from given menu and after that select session: 

 

• Attendance:  In attendance module, The class counselor will work on registration of new students . 

Menu under Attendance 

a. Student Wise Registration 

b. Regular Subject Registration new 

c. Regular Subject Registration verification 

d. Repeat/Retest/Summer registration list 

In Subject Wise Student , we can check detail of student like as of their fee, whether he has registered for 

exam, and not any dues are pending by filling all the required fields as per screenshot. 

 

http://10.1.0.105:8081/


 

In Regular Subject Registration,  we can check how many students has registered,  in VIEW STUDENT tab 

we can check list of registered students under that particular programme. 

 

There is a list of registered students: 



 

In this there is VIEW SUBJECT Tab, in which we can check about subjects which particular student has 

registered and that has approved by counselor, and it shows all about fees record like as follow: 

 

In Regular Subject Registration Verification  we can verify about the registered students under that particular 

course and programme. 



 

We can take print also of registered students. 

In Repeat/Retest/Summer Registration List  

 

By selecting programme type and exam name (Session Wise),We Can Export this list into Excel Also 
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ERP URL: http://10.1.0.105:8081/ 

Log in Process: Login with credentials provided by System Administrator (ACSS Section).  

 

 

 

 

 
 

 

After successful login, you will be requested to choose your role and academic session. 

 



 

 

2. Dashboard: 

After selecting the role, you are taken to your dashboard.  

In the dashboard, you have messages and notices in the first view.  In the left side of home 

screen, you have multiple options such as:  Message -> Student MIS -> Attendance -> Exam -> 

COS -> Payroll -> Security. 

You can click directly any one of the above mentioned options as required. 

 



 

 

3. Student MIS 

If you want to check your any information regarding your students, this is the tab, where you will 

get the complete information of registered students, subjects, time table coordinator name and 

exam schemes. 

Student MIS -> View all academic details 

 

 



 

 

 

 

 

 



 

For Example: You want to check the information of Computer Science Engineering Department. 

Click on Select tab. 

 

 

 

Now, You will redirected to next screen as below: Here you can find the related information of 

the  Programme Type, Programme, Sem,  Sec,  Active Student, Drop Out,  Year Back, Time 

Table Incharge, Class Counselor, Academic, Students. 

 

 

 

 

After clicking on View Student, you will be redirected to respective course  students page. In the 

following example  ICD, DCS-CDE, Semester 2, Sec-CD is selected for illustration purpose.  



 

 

After clicking on View subject, you will be redirected to respective course, faculty name, 

subject code page. In the following example  ICD, DCS-CDE, Semester 2, Sec-CD is selected 

for illustration purpose.  

 



 

After clicking on student registration, you will be redirected to registered students page. In the 

following example  ICD, DCS-CDE, Semester 2, Sec-CD is selected for illustration purpose.  

 

 

 



After clicking on view exam, you will be redirected to registered students page. In the following 

example  ICD, DCS-CDE, Semester 2, Sec-CD is selected for illustration purpose.  

 

 

 

2.Subject Registration: 

• Subject Wise Student  

• Repeat/Retest/Summer Registration 

• Upload Assignment 

• Add Assignment 

Subject Wise Student: it shows all detail of students according to their subjects. 



 

     Figure 1 Subject Wise Student 

In This, Faculty can check the list of students under any course for any particular subject. Like as in 

above picture faculty can view the no. of students under any particular course for any subject. 

Repeat/Retest/Summer Registration List: you can check all the detail of students who have 

applied from these three type of tests by selecting required fields: 

Programme Type→ Select any type of Programme (i.e ICD, UG, PG) 

Exam Name→ Repeat/Retest/Summer (for any session) 

In this Menu we can check the no of students of list of students who have applied for any type of  

Exam like as any of Retest, Repeat or summer exam for any session year i.e May-2022, Dec-

2021 etc. 

There is an approved list under these type of exam for any Programme type and faculty can 

export this list into excel for further any necessary action or requirement. 



 

       Figure 2 Registration List of Repeat/Retest/Summer Test 

Upload Assignment: In this faculty can upload the assignment or can view that he has uploaded 

and can download that also. 

Under this faculty can view only for assigned subject’s assignment , and can download that  

uploaded assignment . 

 

 



Add Assignment: Under this menu type faculty can upload or add any assignment of any subject 

for any particular topic, that will be visible to students for that course. 

Add Assignment   

 

 

 

Click on Add Assignment button , By clicking on this it will appear like as below 

 

In this window, Select Assignment → Topic→ Upload Assignment→ Remarks and save it. 

The list of Uploaded assignments for that selected course and section it will create below. From which h 

faculty can view uploaded assignment by downloading again or can delete if there is any problem. 

3. Time Table 

• Create Time Table 

• Time Table (Sem)  

• Time Table(Room)  

• Time Table (Teacher) 

Create Time Table:  



 

Figure 3 Create Time Table 

In this menu type, faculty will create his own time table like as above. 

 In Programme Type(Select ICD, UG, or PG) → Select Branch→ Semester→ Class→ Subject→ 

Group→ Lecture Type(Lecture, Tutorial, Practical)→ Day of week→ Period→ Class Room 

After that save it and faculty can view the created time table as below and can delete that particular entry 

if there is any incorrect entry. 

 

 

 

 

Time table (SEM): In this menu type , faculty can check his own time table for any allotted semester 

subjects of any Branch or course under any allotted Programme type. 



 

Figure 4 Time Table (SEM) 

Time Table (Room): In this Menu type, faculty can check time table according to room also like 

as below picture. 

 

Figure 5 Room Wise Time Table 

Time Table (Teachers): In this menu type, Select Department→ Faculty Name  and click on 

Load button. There time table will appear accordingly and faculty can export that into excel. 



 

Figure 6 Time Table (Teachers) 

4. Exam 

In this Menu , there are below mentioned sub- menu types: 

• Regular Exam Attendance Sheet 

• Repeat Exam Attendance Sheet 

• Marks Enter 

• Attendance Marks Enter 

• Marks Enter Retest 

• Marks Enter Repeat. 

• Exam Marks Verified By Faculty 

• Student Detail with Email (R) 

Regular Exam Attendance Sheet: In this sub-menu, here faculty can take print of the student 

list as in the format of attendance sheet of assigned subject for any type of paper like as below: 

Select Teacher Name→ Subject→ Paper Type 

The list will appear that faculty can take print of that attendance sheet. 



 
Figure 7 Print Attendance Sheet 

 

   Marks Enter: In this Sub-Menu, faculty can enter marks manually for assigned subject and 

course or faculty can upload excel sheet of marks directly that marks will update in students 

accordingly. 

 

Now, Firstly Select  Teacher Name→Subject→Upload Excel File.  

Click on Teacher Name tab, you will see your allotted subjects here. If any subject or none is 

available in the drop down list, contact to your time table coordinator. 

There will be the list of subjects that are allotted to you. Only for these subjects faculty can enter 

marks of students under that course and subject. 



 

 

Now, click on the respective tab of subject, in which you want to enter the marks. 

Here, you have multiple options to upload the marks such as by uploading excel file or inserting 

the marks by clicking on load tab 

 



 

 

You can export the entered marks list for your reference if necessary.   

Attendance Marks Enter:  In this Select Exam Name→ Teacher Name→ Subject 

Faculty can update or enter marks of attendance for particular subject which that faculty is 

teaching to students. 

 
Figure 8 Attendance Marks 



Now, verification of entered mark s is mandatory step.   

Marks Enter Retest: Under this type of sub-menu, faculty can enter marks for Retest held by 

the institute. 

There is Retest Exam held for different sessions, under this faculty will select that option and can 

fill the marks of that students who have filled the exam form  

 
Figure 9 Repeat Exam Marks Enter 

In the same case of Marks enter repeat, faculty can enter marks for repeat exam held by institute 

for different sessions. 

Re-enter Exam Marks: In this sub-menu type Faculty can enter the marks again for main exam. 

Under this there is View Subject button, By clicking on this the following window will appear to 

fill exam marks by clicking View_Exam button. 

 

 
The following window will open to fill exam marks in the given space below. 

 



 Exam Marks Verified By Faculty:  

Here, lock/view & print award sheet options are available. . If any modification in marks is 

required, you can change your entered sheet before lock. But once, you clicked on lock option 

and forward to HOD, you cannot modify your entered marks. The following screens are for 

illustration purpose.  

 

 



 

Once you have locked your marks successfully and forwarded to HOD, you can take print by 

clicking on award-sheet tab.  

 

       Figure 10 Award Sheet 

 



5. TGSMS: Tutor Guardian Mentor Scheme 

 

Add Faculty Tutor: In this type of sub-menu, faculty can add class room by clicking on Select 

button for any particular department. 

 

By selecting department, the following window will appear to faculty for further necessary 

action. Under this sub-menu the list of Tutor has to add from list of different faculty members 

like as below. 

 



 
Figure 11 Add Faculty Tutor 

 

Add Student Tutor: Under this Faculty will add Student for tutor. There list will appear of trade wise 

students to add them under any tutor. 

 



 
Figure 12 Add Student Tutor 

Add Student as Mentor: Under this, faculty will add any student from students’s list of any trade as 

mentor of some students. Faculty can search the student also, from list of students. 

 

Add Mentee for Mentor: Under this faculty can add mentee(no. of students) for that assigned mentor. 

 

 

 



Tutor Guardian List: From there faculty can check tutor Guardian list as created above lists. 

This list can view in different ways like as below given buttons on screen: 

a. View All student Faculty Wise 

b. View All student Programme type 

c. View All student Trade Wise 

 

There is list of add students of different trades. Faculty can view the students under different trades also. 

 

Figure 13 List of students Faculty Wise 

 



View All Student Programme Type: Through this Faculty can check total no of students under any 

Programme type and faculty member. 

 

Figure 14 Programme Type Students List 

View All student Trade Wise: Through this menu faculty can check list of students trade wise under any 

faculty member.  

 

Figure 15 Trade Wise Students List 

All these lists can export into Excel also for any further necessity. 

Student Mentor list: Under this sub-menu, Faculty can check Mentor-Mentee Ratio. From which faculty 

can check there is equal distribution of Mentors to each Mentee or not. 
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ERP URL: http://10.1.0.105:8081/ 

Table of Contents: 

• Attendance 

o Mapping of Subject to faculty 

• Exam 

o Award List verification 

• Placement 

o Training And Internship 

• No Dues 

o Create Lab 

o Update Lab Incharge 

o No Dues Approved 

• Security 

o User Privilege View 
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1. Attendance: 

 

a. Mapping of Subject To Faculty: 

View Subject➔Select Department from list➔Select Faculty➔Click on Update Faculty 

 

After clicking on update faculty, the faculty name will change under that subject.  



 

Figure 1 Mapping of subject to faculty 

As in above picture, HOD can delete that subject if any has updated by mistakenly. 

From this HOD can update the record by changing faculty name under any particular subject. 

From upper field Select Department, select department name and in field select faculty, it will show all faculty 

names under that department which we have selected, then select that particular teacher name which HOD 

want to assign for that subject in front of that subject name. 

2. Exam: 

Award List Verification: There are two types of list: List for verify and Approved List 

In List for verify, there are 3 Tabs at this screen for different purposes. 

a. Roll Back: To roll back all that data. 

b. Final Update: For final submission of data which has given for verification. 

c. View Subject: To check subject under that Programme type and faculty. Under this there is further 

View Subject Marks Tab, to check marks status under that subject. 



 

 

Under View Subject:  

 

This list is not approved, otherwise by clicking on View Subject Marks Tab we can check marks in that 

subject. And can check award sheet list also. 

If we open by clicking on Approved List tab then it will look like as below: 

 



 

   Figure 2 Approved List to check Award List 

 

       Figure 3 To check subject marks and award sheet 

Under this we can check marks under any particular Programme and can check award sheet related to that. 

HOD will lock all that record under subject marks and will send reports to academics. 

3. Placement: 

a. Training and Internship: Under this there are three types of list: Lock List, Unlock 

List and View All. 

The main screen will as like below: 



 

After selecting View All, The list will as like below: 

 

In this, there is all the record of internship and training students. HOD can approve or reject the internship and 

training of any student under which company student has registered in case of any issue or change in any 

curriculum. If approval has finalized by HOD then student can check his/her training under registered 

company and can go for that. 

 

 



4. No_Dues 

 

a. Create Lab: 

Add Lab→Insert/New Entry→ Delete / Update Entry  

 

HOD can make new entry regarding any updation or can edit in previous created labs. 

b. Update Lab Incharge: Update Employee→ Update Room Incharge 

 

HOD can change Lab incharge Name under this menu, click on update Employee 



 

 

Select department name, employee name from given list then click on update Faculty. 

It will make change under that list from which we have make change. 

c. NO_Dues Approved: View Student→ View Details 

 



 

Figure 4 No Dues Lock Inquiry 

In this, there is entry of the students who have not pending any dues.  

 

Through this we can check all deptt. wise dues of each and every student under each Programme of different 

semesters. 

5. Security: 

a. User Privilege View: Under this as required fields have to fill and then list will generate, 

from which HOD can assign section and class according to that to upper selected teacher. 

Like as there  



 

Figure 5 To assign role to different teachers 
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Dashboard 

In this there are these facilities which a Hostel Assistant can check: 

 

There is Hostel Menu under which there are : 

a. Room 

b. Room Allotment 

c. Hostel Fee Room Wise(Report) 

• In  Room Menu: 

 In this room can check how many rooms and hostels are there, and can check no of rooms  in each hostel 

.Hostel Assistant can add new room  from ADD ROOM Tab. 

 

Under this tab, the list will open of available rooms, assistant can update room type from given tab. 



 

From this Tab ,we can update the room type like as it is for multiple sharing or single bed  room, And can add 

more rooms in list by filling above given fields and after that click on Insert Tab. 

• In  Room Allotment Menu: 

 

 In this we can check no of rooms in no of hostel. 

To allot the room we will click on Room Allotment menu, after that 



 

This link will show all the no of students list under each programme type under different sessions , Like we 

want to check under PHD Programme,  click in front of that tab, and after that select session 

 

   Figure 1 To check Session Wise Students List 

Like under this session click on VIEW ALL STUDENT Tab, It will show all the students lists to whom room 

has allotted in Hostel. 

 

There are two types of lists: one for Day scholar Students and other one is for Hosteler students 

It shows also that which room has allotted that is for Part time or full time. 



And after that we can also view the room by clicking on VIEW ROOM Tab. Under this we can check about 

Room No, time period for which that room has allotted. 

 

                   Figure 2  To update or Delete the Allotted Room 

We can update it for further more time period, or can delete . 

 

     Figure 3 To Approve Room 

We can Approve or remove the room from that student also by clicking on Approved Tab. 

By clicking on Approved Tab , can also remove Hostel Fees from that particular student or can allocate fee to 

that student if student want to take hostel room.  

From VIEW FEES Tab we can check about fees status, that has how many fees has submitted by student . 



• In ROOM FEES REPORT: In this menu Hostel Assistant can check room wise fees report of each 

and every student. We can export that data into excel also by clicking on given excel icon on screen. 

 

                                 Figure 4: To check Room wise Fees and export data into Excel 
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Select here Role after Login 

 

     By selecting No_Dues Update, then after that select session . 

 Main Dashboard page will open: 

       

a. Update Lab Incharge:  

 



Click on Update Employee, it screen will appear  

 

Click on update Lab Incharge to change incharge of any lab. By clicking on this tab , the screen will 

appear from where we can change any employee name by selecting department name first and after that 

select name of employee related to that department, like as in below screen: 

 

Then click on Update Faculty then it will change the name of lab incharge to related lab. 

b. No-Dues Allow: There is a two types of  list : Pending and approved 

You can allow here for NO-DUES . 



 

 

 



Sant Longowal Institute of Engineering and Technology 

(Deemed-to-be-university, under Ministry of Education, Govt. of India) 

 

 

 

 

 

ERP User Manual for Payroll 

 

 

 

 

 

 

 

 

 



ERP URL: http://10.1.0.105:8081/ 

Payroll: Salary Auth. Signatory→ Pay Band View →Add Employee for Salary→Employee Serial No → Salary 

Head Serial No→ Update Account no →New Month→ Create Formula→ Set Grade Pay→ Guest Staff Basic 

Pay→ Add All Allowances→ Set Allowances→ Establishment Return→ Establishment Return Supplementary→ 

Arrear Entry→ Leave Encashment→ CPF Employee Wise→ Salary Processing→ Salary Register→ Salary Slip→ 

Income Tax Quarterly return→ Salary reports→ Annual Salary Register→ Employee_ Info→ Define Salary 

Type→ Leave Defining→ Salary Rate Editor→ Salary Dispatch Monthly→ Salary Dispatch New→ Update 

Employee Type→ Staff Update → Staff(New) 

a. Salary Auth. Signatory: 

 

In this to whom we want to give signature authority under which register type , that we can do . 
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b. Pay Band View 

 

Figure 1  To view Pay Band of Teaching and Non-Teaching Staff   

c. Add Employee for Salary: View Employee→ Add Employee 

 

After click on View Employee , we can check All staff wise list under different salary type staff. 



 

In Remove Staff List we can remove that particular staff member from that list like as in below screenshot. 

 

Figure 2 Add/Remove staff for salary 

d. Employee Serial No.: In this we can check the serial no of different staff members with of different 

departments. 



 

    Figure 3 To Check Employee Serial No. 

e. Salary Head Serial No.:  

 

 



f. Update Account no. 

 

g. New Month 

 

 

 



h. Create formula: View Head→ View Update→ View Head→  

 

i. Set Grade pay: View Head→ Select salary type→  

 



  

 

 



j. Guest Staff Basic Pay:  View Head→ Select Department→ View Head→ Calculate 

 

      Figure 4 To calculate Basic Pay of staff according to Lecture delivered 

k. Add All Allowances: 



 

l. Set Allowances: 

 

m. Establishment Return: 



 

 

n. Establishment Return Supplementary: 



 

 

o. Arrear Entry: 



 

 

p. Leave Encashment: 

 



View Head→ Select Department→ View Update→ View Leave Encashment 

 

 

q. CPF Employee Wise: 



 

r. Salary Processing: View Head→  

 



 

s. Salary Register: 

 

 



t. Salary slip: 

 

Click on view after filling the required fields, the salary slip will be generated like below: 

 



u. Income Tax Quarterly Return: 

 

v. Salary Reports: 

 



w. Annual Salary Register: 

 

x. Employee _ info: 

 



y. Define Salary Type: 

 

z. Staff Update 

 



It shows the updated staff  list by selecting department type. 

aa. Staff(New): we can make new entries of upcoming/new staff members. 
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ERP URL: http://10.1.0.105:8081/ 

Placement Section 

There are some features under Placement Menu. 

 

1. Company Master: The new company registration can done here, and it shows registered 

companies list here also. From that list if we want to delete that registered company then 

that can do by clicking on red cross tab.  

http://10.1.0.105:8081/


 

Figure 1 Registration Process for new Company 

 

        Figure 2 Registered Companies List 

2. Company Details: In this we can check company details under this link and can register 

for job. 



 

By clicking on Job Profile we can register for any job. 

 

After inserting your job profile , it will add in that company profile. 

 

 



3. Mapping Company year:  

 

          Figure 3 Session Wise Companies Mapping 

In this link we can add company detail according to year. 

4. Company Assign: 

 

There is VIEW tab , under that you have to select particular fields for conducting interview. 



 

5. Placement other Entry: 

       If we want to register any student for any other company, through t his page we can make entry 

for that. 

 

By filling these required fields , we can make entries for making placement of students as per required. 



6. Placement Report: 

• Student List percentage wise 

• All company summary 

• Exam wise summary 

 

 In this you can make entries accordingly and check Exam Wise Summary and All company Summary by 

clicking on given buttons for inquiry.  We can export the  report into excel also. 

7. Placement Report ll:  In this you can check whether who has applied for which company 

according to their session by filling the required fields. 



 

8. Training Report: Under this you can check training report and Internship report by selecting their 

batch /course accordingly. 

 

9. Placement Chart View: 



 

Under this you can check department wise no. of  percentage of students who have placed  in companies. 
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STUDENT_LOGIN 

Portal Address: http://14.139.242.71:8085/login.aspx 

After Login: 

Contents: 

1. Placement 

a. Education Detail New 

b. Placement Registration 

c. Internship and Training 

2. Student Login 

a. Profile update 

b. Semester wise Student Feedback 

c. Semester Fee 

d. Student Activity Registration 

e. Semester Registration 

f. Repeat Subject Registration 

g. Retest Subject Registration 

h. Department Fee Paid 

i. View Repeat/Retest/Summer Subject List 

j. Fee For Various certificates 

k. Print Fee Receipt 

l. Apply No-Dues 

m. Certificate Details 

n. Mentor Details 
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1. Placement : After Login, There is  

 

Figure 1 Student Login Dashboard 

a. Education Details: Under this student have to fill about his all education details for 

registration under placement, and Student has to upload his all that educational documents. 

 

Figure 2 Education Details 

 

 

 

 

 



b. Placement Registration: In this sub-menu type, student can register for different companies 

for his own placement. Like as below, there is list of companies from which student can apply 

by clicking on link given in Link for Apply column. 

Student can download Terms and conditions of these companies by clicking on given download button in 

Download Column. From this list student can check also about apply date so that student can apply on or 

before that mention date. 

 

 

 

 

 

 

 

 

 

 

 

 



c. Internship/Training: There is Request Letter, Confirmation Letter 

Under Request Letter, student can apply for Internship or training under any particular industry. 

Under Confirmation Letter, student can take  

 

2. Student_Login: 

a. Profile Update: Under this sub-menu there is profile update page where student can update data 

or information about himself like as personal Information or his education Details etc. 

Student can update his contact Detail and can upload his own documents also. 



 

Figure 3.1 Update Profile Like Basic Information 

 

Figure 3.2 Contact Detail and Documents 

d. Semester wise student Feedback: In this type of menu student can update his own feedback 

about his course subject’s teaching method and about teacher’s teaching methodology etc. 

 



 

Figure 4 Student Feedback for each subject 

e. Semester Fee: Through this sub-menu type, student can check his fee status and can fill his fee 

online. 

 

Figure 5 Online Fee payment 

 



f. Student Activity Registration: Under this type of sub-menu, student can make his registration 

for any type of activity for any particular subject by selecting given detail as per in below 

screen. 

Select Subject→ Select Activity and then after that click on Insert new entry. 

It will show that detail of selecting activities in which student has done. 

 

g. Semester Registration: Under this, student can view his subjects for which student has 

registered. Like as in below screen, student can not change his subjects, can check only. 

 



h. Repeat Subject Registration: Under Repeat subject registration sub-menu, student can apply 

for Repeat exam .  

Like as in below screen there Arrow1, firstly will select exam type and subject, and after that from Arrow2  

student can make payment for that registered subject. 

if there is any student who haven’t appeared  in previous session, then student can also register for that exam 

through this process. 

 

Figure 6Registration for repeat exam 

 

 

 

 

 

 

 

 

 

1 
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i. Retest Subject Registration: As in Repeat Subject Registration, same process will be continue 

in this Retest Subject Registration. 

Student will select Exam Name and after that he can make payment for that registered subject. 

 

j. Department Fee Paid: Under this if there is any fine has applied to student or any other type 

of facility student want to take or taken then student can make payment for that through this 

page. 

k. Change Basic Details: in this student can change their own mobile no or email-id  and after 

that click on update to save that changes. 

 

 

l. Fee for various certificates: Under this type of sub-menu student can check fee for various 

certificates and can make payment for that. There are two types of certificates : 

• Paid Certificate 

• Un-Paid Certificate 

 



There is Paid certificate’s list from which student can check fee of any certificate and can register for to issue 

that certificate. Select Make Payment button and can make online payment for that certificate and after that 

he can take that certificate from Academic Department. 

Regarding any other Fee Issue then contact to Account and Finance Department. 

 

As there are many types of certificates under Paid certificates like as Migration certificates , Postal charges( 

Speed Post any certificate), Income Tax Certificate etc, that student can check under this that which amount 

has to paid for any particular certificates. 

m. Print Fee Receipt: Under this Student can take print of their paid fees amount receipt or can 

check their fee status. 

 

From there by clicking on PRINT link student can take printout of paid fee for further any requirement. 

The Fee receipt will like as below. 



 

Figure 7 Fee Receipt 
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ERP URL: http://10.1.0.105:8081/ 

Time Table Counselor:  Counselor works for allotment of subjects to different related subject teachers. 

 View Academic details→ select programme→ View subjects→ view exam 

 

In this we can click on select tab to check programmes in different programme type. 

 

In above picture, from here we can check or view subjects in each Programme of different sections, if there is 

any problem then contact to related Time Table Incharge as mentioned above. 

We can check this after ERP login. 

Under each and every Programme , time table counselor has allotted the subjects to each department and 

make different sections time table accordingly. 

http://10.1.0.105:8081/


 

Figure 1 To check/view  exam under each programme 

After Click on View Subject→ View Exam→ Attendance Sheet 

In this we can check how many types of exams are there under that each Programme , and further that we can 

create attendance sheet accordingly,. 

 

Figure 2 To create Attendance sheet 

 



 

In this page , we can also download the excel sheet of this attendance sheet. 

After Click on View Subject→ Student Registration 

 

Under this , we can check the registered students under each Programme and can export that data into excel. 


